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Safety Information 
 

 
The PY-2020iD has been designed and tested in accordance with EN directives 
 
 
Whenever the safety protection of the PY-2020iD has been compromised, disconnect the unit 
from all power sources and secure the unit against unintended operation. 
 
 
 
Safety Symbols 
 
This manual contains safety information that should be followed by the user to insure safe 
operation. 

 

 

WARNING 
A WARNING CALLS ATTENTION TO A CONDITION OR POSSIBLE SITUATION 

THAT COULD CAUSE INJURY TO THE USER 

CAUTION 
A Caution calls attention to a condition or possible situation that could 

damage or destroy the product or the user’s work 
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WARNING 
FOR YOUR SAFETY 
1) Wear safety glasses during the installation, troubleshooting and operation. 
2) Although the pyrolyzer is fully covered by meshed cover for your safety, the temperature of the 

cover can be 50~80ºC when it is in operation.  Do not touch the pyrolyzer with bare hands. 
3) In the event where inspection or removal of the pyrolyzer is required, make sure it fully cools down 

and unplug the power cable. 

 BEFORE USING THIS PYROLYZER 
 
1. Thank you for purchasing the pyrolyzer from Frontier Laboratories Ltd.  Read through this 

operation manual carefully before attempting any operation, especially if you are a first-time 
user. This manual is designed to assist you with your daily operations. 

 
2. This manual contains categorized descriptions of general notes on pyrolyzer, operations, 

maintenance, trouble-shooting, and others.  We highly recommend that you read this manual 
along with the operation manual of the gas chromatography you are using. 

 
3. Replacement parts are described in Appendix-1~2.  Parts can be obtained from your dealer 

or directly from Frontier Laboratories Ltd. 

Physical appearance and specifications are subject to modifications for product improvements. 

 

PRODUCT WARRANTY 
 
Frontier Laboratories Ltd. warrants the product you purchased in the following terms and 
conditions. 
 
1. Warranty period 1 year from the date of complete installation. 
 
2. Warranty service During the warranty period, if the product fails due to the defects in 

material or workmanship, Frontier Laboratories Ltd. will repair the 
product free of charge. 

 
3. Items not warranted Even during the warranty period, the warranty does not cover failures 

due to the items listed below, and the product will not be repaired 
free of charge. 
 

   1) Improper installation. 
   2) Misuse and abuse. 
   3) Dislocation or shipment after initial installation. 
   4) Disassembling or alterations. 
   5) Fire or natural hazards such as earthquakes. 
   6) Replacement parts and parts whose warranty is limited. 

 

DESCRIPTION OF ESPECIALLY IMPORTANT NOTES AND SAFETY 
PRECAUTIONS ARE FRAMED LIKE THIS.
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CHECKING CONTENTS IN THE PACKAGE 
We recommend that you first examine the contents of the package you have received. If the 
contents differ from the package list below, or some items are missing, contact your dealer 
immediately. 

LIST OF CONTENTS 
Item Part No. (P/N) Qty. Check

A.  Pyrolyzer 
Refer to Replacement parts 
list (Appendix-1) 1set  

A1 Pyrolyzer ------------- 1  

A2* Double-Shot Sampler PY1-1020 1  

A3 Liquid Injection Sampler (attached to the pyrolyzer) PY1-1030 1  

A4 Double-Shot Sampler Stand PY1-2022 1  

A5 Storage Stand PY1-3610 1  

A6* Sample Cup (Disposable Eco-cup SF)    PY1-EC50F 20cups  

A7* Sample Cup (Disposable Eco-cup LF)    PY1-EC80F 20cups  

A8* Eco-stick SF                          PY1-ES10F 10pcs  

A9* Eco-stick DF                           PY1-ES20F 10pcs  

A10* Sample Cup Stand (Eco stand) PY1-EH10 2  

A11* Eco-cup Picker (Eco pick-up) PY1-EP50 1  

A12* Quartz Pyrolysis Tube PY1-2018 3  

A13* Graphite-Vespel Ferrule for ITF (6mm id)   (5 pcs/pk) PY1-7911 1  

A14* Interface Needle Assembly (w/2 spare needles) PY1-3510 1  

A15* Interface Needle set                      (3 pcs/pk)    PY1-1174 1  

A16* Pretreated Septum                      (5 pcs/pk) PY1-7302 3  

A17* Heat sink adaptor (screw 2ea,hexagon wrench 1.5mm) PY1-3570 1  

A18* Level vial PY1-7131 １  

A19* Septum For liquid sampler PY-2025 5  

B.  Temperature Controller   

B1 Temperature Controller ------------ 1  

B2 AC Power Cable PY1-7003 1  

B3 Nylon Tube (for cooling air, 1.5m) PY1-7801 2  

C.  Accessories  

C1 
System Check Column 
(5% Methyl silicon, 30m (0.25mmø) 0.25µm) UA5-30M-0.25F 1  

C2* 
Standard Sample (polystyrene solution 6µg/µl  
contains methyl ester, 0.5ml) PY1-4905 1  

C3* 
Tool Kit (tweezers, wrench, hexagon screwdriver, O-ring 
(SM-6) PY1-K020 1  

C4 Deactivated Metal Capillary Tube for EGA  
Ultra ALLOY® 2.5m (0.15m id) UADTM-2.5N 1  

C5 Operation Manual (this manual) PY1-7015 1  

C6 Communication Cable (RS-232C, D-sub 9 pin female) PY1-7811 1  

C7 Control Software (CD ROM) PY1-5801 1  

* Indicates that the item is included in the accessory container.
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OPTIONS (see Chapter 8 for other replacement parts) 

1) Sample Cups 
  (Platinum sample cups for Single-Shot Small (SS) and Large (SL) 

for Double-Shot Small (DS) and Large (DL) are available) 
 

2) Auto sampler stand for HP5890A (specify one from the list below) 
  a. Auto sampler stand (Agilent Part No.: 18597-60255, newest type) 
  b. Auto sampler stand (for older type than a. above) 
  c. Mounter integrated with 100-sample tray 
 

3) Mounting Kit for Shimadzu GC (available for GC-17/18/2010/14) 
 

4) Selective Sampler (SS-1010E) 
 

5) Carrier Gas Selector (CGS-1050E) 
 

6) F-Search Ver.2 (Polymer EGA and Pyrogram-MS Library, ADD-MS Library ) 
(PY-1082E) 
 

7) MicroJet Cryo-Trap (MJT-1030E) 
 

8) Auto-Shot Sampler (AS-1020E) 
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CHAPTER 1  ABOUT DOUBLE-SHOT PYROLYZER  
 
1.1 BACKGROUND OF DEVELOPMENT 

 
Pyrolysis Gas Chromatography (Py-GC) allows analysis of almost all sorts of materials 
including insoluble materials and complex materials at trace levels without any pretreatment 
of samples, and information otherwise unobtainable by other techniques can be obtained; 
therefore, Py-GC technique is becoming more important technique in the area of polymer 
characterization. However, pyrograms obtained by this technique have problems with 
reproducibility and difficulties in eluting polar and high boiling species. 

We at Frontier Laboratories have addressed these problems and developed a highly 
improved pyrolyzer based on a technique in which a small cup loaded with a sample is 
dropped into a small sized vertical furnace by gravitational free-fall at room temperature, 
affording a pyrolysis time of less than several tens of milliseconds. This system is designed 
to provide precise temperature control and minimal condensation of pyrolyzates in the 
system with unparalleled reproducibility. In 1992 we commercialized Double-Shot Pyrolyzer 
(PY-2010D). 

This double-shot pyrolyzer offered completely new dimension in polymer analysis in which 
volatile components and fragments originated from polymer pyrolysis can be separately 
analyzed. This feature was not available in conventional pyrolyzers. To accomplish this, 
volatile components are first analyzed at 100 ~ 300ºC at a programmed rate or at a constant 
temperature, this is followed by instantly heating the basic polymer to 500 ~ 800ºC by 
dropping the sample into the pyrolysis furnace with a free-fall mechanism. This double-shot 
pyrolyzer offers two techniques on a single system. We commercialized conventional instant 
pyrolyzer with the free-fall mechanism as Single-Shot Pyrolyzer. 

In 1993 utilizing the Double-Shot Pyrolyzer with highly precise temperature controlled 
programming, we proposed the Evolved Gas Analysis (EGA). With this new technique, 
volatiles and pyrolyzate gases from a polymer sample evolved continuously at programmed 
heating process are introduced directly into an analysis system such as GC or mass 
spectrometer (MS). Because evolved gas curves similar to Thermal Gravimetric analysis 
(TG) can easily be obtained with this technique, EGA is currently widely used in research 
laboratories for detailed analysis of thermal and chemical behavior of polymers, and also in 
factories as a quality control method.  

Only for the past 6 years, 350 units of the Double-Shot Pyrolyzers have been installed both 
domestically and internationally, and in comparison with other methods such as filament and 
Curie point methods, this device has been proven to be of high reproducibility as well as high 
reliability. 
 
Ultra ALLOY® metal capillary columns we have developed show contamination resistance 
about 4 times greater and 50ºC higher thermal resistance in Py-GC technique than with fuse 
silica (FS) capillary columns and are extremely effective in analyses of pyrolyzates ranging 
from C1 to over C100.  

 
Double-shot Pyrolyzer: patent no. 2742492 
Ultra ALLOY®: the registered trademark of Frontier Laboratories Ltd. 
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Our research and development staff has devoted 15 years in the basic research to improve the 
quality of the Double-Shot Pyrolyzer and have developed the following new products. 

a. Deactivated Sample Cups and Sample Picker - deactivated stainless steel cups with 100% 
retrieving rate at one try (with detachable handle) 

b. Disposable Eco-cup – By achieving deactivation of the stainless steel cups with lower costs, 
this new cup enabled us to offer lower cost and a single-round usage. Herewith, there is no need 
to clean the sample cup to do the next analysis. Moreover, there is no need to concern 
undesirable influences as well as carryover of the previous samples.  

c. Carrier Gas Selector (CGS-1050E) - switchable between two carrier gases 

d. Purgeable Sampler - sampler with purging mechanism 

e. GC/MS Adapter (MS604230) - inexpensive adapter with extremely low leakage at 350ºC 

f. F-Search Ver.2 (PY-1082E) - Polymer EGA and Pyrogram-MS Library, Additive-MS Library 

g. Selective Sampler (SS-1010E) - device that selectively introduces components of any 
temperature range of EGA curve to the separation column 
 

As these peripheral devices have been developed, the double-shot pyrolyzer has created a wide 
spectrum of applications. Our research and development team have continued further efforts in 
improving the system and have developed the next generation Double-Shot Pyrolyzer. The new 
greatly improved system incorporates more thermal analysis techniques allowing more detailed 
analysis of polymer components, precise temperature control from near room temperature as 
initial temperature, and capability to control various peripheral devices for mass spectrometer. 
 

1.2 FEATURES OF PY-2020iD 
Double-shot pyrolyzer PY-2020iD is the next generation pyrolyzer with much improved pyrolysis 
furnace and its temperature control over previous model PY-2010D. This manual describes 
details about this new pyrolyzer. The following summarizes the features of the pyrolyzer. 
 
1. Two important basic performances are guaranteed. 

Inactivity of flow path (judged by peak shapes of polar species) 
Relative intensities of polystyrene pyrolyzates at 550ºC: 14±1.5% 

Their fluctuations: within 2% (with Eco-cup SF) 

2. Four analytical techniques available in one system. 
Single-shot technique 
Double-shot technique 
Evolved Gas Analysis Technique 
Heart-Cut EGA Technique 

3. New algorithm that automatically controls the interface furnace temperature makes it possible 
to program initial temperature of the pyrolysis furnace starting from 40ºC. 

4. Any segment of evolved gas analysis curve can be automatically sampled. 

5. PC control software offers easy operation and easy temperature calibration. 
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Table 1 shows optional peripheral devices that can be attached to Double-Shot Pyrolyzer. 

 

 

 

 

Table1  Analytical Techniques Available for PY-2020iD and With Optional Devices 

 

 

Optional Device 
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Flash pyrolysis (single-shot) Best NA Best Good Best Best Best

Multistage pyrolysis (double-shot) Best NA Best Good Best Best Best

Evolved gas analysis (EGA) Best Best Best Best Best Good Best
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STRUCTURE OF DOUBLE-SHOT PYROLYZER 

 

Double-shot Sampler 

Thermal desorption / pyrolysis furnace 
(40～800ºC) 

Cooling fan 

Quartz pyrolysis tube 

Thermal insulator 

 Liquid sampler 

Sample drop button

Sampler base 

Graphite vespel ferrule 
Mounting screw

        Air purge knob 

Plane A 

 Regulator 

Exhaust

Interface thermal insulator cover 

Interface heater 
(100～400ºC) 

GC Inj port

Sample cup upper position

 
 Sampler cup lower position 

O-ring

Cooling air IN 

Cooling Air OUT 

Split outlet
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CHAPTER 2  SPECIFICATIONS 
   
 (The system consists of pyrolysis furnace with interface, sampler, temperature controller, standard accessories, and options) 
 

                   MODEL Double-Shot Pyrolyzer 
PY-2020iD (Patent No:2742492) 

Single-Shot Pyrolyzer  
PY-2020iS 

1. PERFORMANCE Guaranteed performance  Guaranteed performance  
1. Reproducibility of pyrogram 
2. Full deactivation and minimum 

dead space of Py/GC flow 
path up to the column outlet 

1. Polystyrene Monomer(S) and trimer(SSS) ratio:      
SS/S(%):14±1%, RSD: less than 2% for Trimer  
vs Monomer peaks of S pyrogram at 550°C 

2. No peak tailing with polar test compounds 
 

Same as left  
 
Same as left 
 

2. HEATING & SAMPLING Vertical type of micro-furnace (Double cartridge heating system) 
• PY furnace (patent pending) 

Sample introduction 
Pyrolysis tubing 
Temp. control range & stab. 
Cooling time  

Heat & Cooling by compressed gas 
Free fall push button system 
Quartz 
40～800°C (1°C step), ±1°C for each set temp 
30 min (600 to 50°C, Auto ITF mode)  

Heating only 
Same as left 
Same as left 
100～800°C (same as left) 
N.A. 

• Interface (ITF) 
ITF needle 
Heater 
Temp Control range 
Temp stability 

 
Deactivated needle by multi-layer treatment 
Cartridge heater 
RT - 400°C (1°C step) 
±1°C for each set temp 

Same as left 
 
 
 
 

• Sampler DBL/SGL–Shot :  
(Sample cup moves up/down for thermal desorption 
from sample holding position at room temp and/or 
drops down to the furnace for flush pyrolysis by 
gravity)  

Single-Shot  
(Sample cup drops down to the furnace 
for flush pyrolysis by gravity) 
 

• Sample Cup (patent pending) All deactivated stainless steel cup & stick  Same as left 
 Disposable Eco-cup SF Small:50 ul (deactivated stainless-steel )  

   Disposable Eco-cup LF large:80 ul (deactivated stainless-steel )  

• Liquid Sampler Liquid sample can inject with a regular micro-syringe  Same as left 

3. TEMP CONTROLLER PC control (Install exclusive software in PC for GC or GC/MS) 

• Functional Key  
 

SGL/DBL, EGA multi-temp prog, Automatic EGA 
Sampling, Interface temp, Monitor, File, Function, 
Date/Time 

SGL/DBL, ITF temp and others 
 

•TEMP Control       Furnace 
                 ITF 

30～800°C（1°C step） Temp prog. Capability 
30～400°C (1°C step) Auto/Manual mode 

30～800°C（1°C step） Isothermal 
30～400°C（1°C） Manual mode 

• Furnace Temp Prog. 
Prog. Rate 
Holding time 
Pyrolysis time 

4 steps of multi temp programming 
１～100°C /min (1°C /min step) 
１～999.9 min (0.1 min step) 
１～999.9 min (0.1 min step) 

N.A. 
 

• Over heating Protection PY：820°C,  ITF:420°C Same as left 

• External Communication RS232C (standard for PY-2020 iD) Same as left 

4. Standard Accessories (one year consumable kit) 
• Pyrolysis tube (Quartz) 2 pcs  Same as left 
• Ultra ALLOY Cap. Col UA-5 (5%diphenyl), 30m (0.25mm id) 0.25um Same as left 
• ITF tube for EGA analysis  2.5 m (0.15 mm id)  (Deactivated metal tube) N.A. 

• Standard sample 1 ml (polystyrene 6ug/ul, additives: fatty acid esters) 1 ml (polystyrene, 30 ug/ml) 
• Tool, sample cup etc. 1 set Same as left 

5. Miscellaneous   

• Power requirement AC110V ±10% (50/60 Hz） 4A Same as left 
• Size (W x D x H)/ ( kg ) 

Pyrolyzer 
Temp. Controller 

 
76 x125 x 260 mm / 2kg 
160 x 280 x 360 mm / 5kg 

Same as left 

• Recommended GC Agilent 7890, 6890GC, Agilent5975 GC/MS, Shimadzu 
GC-2010, QP2010, QP5050 and others 

Same as left 
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6. Options  • Auto-Shot Sampler (AS-1020E) 

• F-Search Ver.2 (Ｐｏｌｙｍｅｒ EGA and Pyrogram-MS Library, Additive-MS Library) (PY-1082E)

• Carrier Gas Selector (CGS-1050E, use of air, He, and Selective Sampler is recommended) 

• Selective Sampler (SS-1010E, any segment of the curve in EGA is selectively sampled.) 

• GC/MS Adapter (MS604230, max temp : 350ºC) 

• Ultra ALLOY® Metal Capillary column (0.25, 0.5, 1.2mm id; length : 5~60mm, wide 

selections of chemically bonded stationary phases available) 

USER PREPARATIONS 

1. Gas chromatograph (with split/splitless injection port): Some restrictions exist depending on models. 

2. Nitrogen gas or compressed air source (for cooling PY furnace, pressure: 400~600kPa) with 1/8" od or 3mm od tube (copper or 

stainless steel) immediately accessible from Temperature Controller. (flow rate: 7L/min) 

3. PC requirements: OS  Windows 98, NT(service pack 5.0 or later), 2000, XP English, Vista, required disc space : 10MB, 

one RS-232C port (Auto-Shot Sampler requires another RS-232C port) 
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CHAPTER 3 INSTALLATION 
3.1 Before Installing Pyrolyzer 

1. PC controlled Double-Shot Pyrolyzer (PY-2020iD) requires N2 source or compressed air for 
cooling. Make a cooling gas tube with o.d. 3mm or 1/8” available in the vicinity of the 
temperature controller.  The end of the tube is cut off and is connected to the temperature 
controller with a 1/8” ferrule and a nut. 

2. Power source of AC 100V (4A or greater) (a 3P power outlet with a grounding wire required) 

3. Allow 20cm wide space at either side of GC or GC/MS. If other optional devices are 
connected to the Pyrolyzer, reserve space for them. 

4. If your GC has multiple injection ports installed, they interfere with Pyrolyzer, because the 
injection ports are situated close together.  If this is the case, Pyrolyzer is connected to the 
one in the back. 

5. If Auto Sampler for liquid samples (AOC) is installed, remove it.  AOC cannot be used 
simultaneously with Pyrolyzer. 

6. To check the performance of Pyrolyzer, Ultra ALLOY capillary column (5% phenyl silicone, 
length 30m, id 0.25mm, film thickness 0.25µm), supplied as a standard accessory, is used.  
If the performance check is to be conducted with GC/MS, it is recommended, prior to 
installation of Pyrolyzer, to follow the steps below to prepare for MS analysis in order to save 
time for installation. 

<<Preparing for MS analysis>> 

Allow the MS open to air. Attach the column for performance check to the injection port and 
run He carrier gas through it for 5min.  Connect the column outlet to the MS.  Then remove 
the column from the injection port, and immediately stopper the column inlet by sticking it into 
a septum and start pumping down vacuum of MS.  After installation of Pyrolyzer is complete, 
remove the septum and cut off 1cm of the column end and reconnect it to the injection port.  
(We recommend that this should be done as quickly as possible.) 

 

Installation of Pyrolyzer (PY) onto Shimadzu GC-2010, as an 
example, is described here.  For installation on the other GCs, see 
the instruction manual that comes with Pyrolyzer Installation Kit.

WARNING 

1. The control cable from the pyrolysis furnace (PY) must be connected to the 
temperature controller AFTER installation of Pyrolyzer onto GC is completed. 
(This is to avoid heating of pyrolysis furnace during the installation of Pyrolyzer.) 

2. Before starting installation, set the GC injection port temperature to OFF and make
sure it is fully cooled down, to avoid the risk of burns. 

3. The tip of ITF needle is sharp.  Wear a pair of safety goggles and execute 

cautions when handling. 
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3.2 Overview of Modification of Carrier Gas Flow Path 
 
Fig. 3.1 shows carrier gas flow schemes before and after the installation of Pyrolyzer.  Refer to 
these schemes at each step of installation. 

 

 

Fig. 3.1  Flow Scheme Before and After Pyrolyzer Installation 

Back pressure 
Regulator 

Flow 
Controller 

 

GC Inj 

BEFORE INSTALLATION AFTER INSTALLATION 

Joint

Flow 
Controller

 

Plug 

Py 
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3.3 About Installation Kit 
 
For installation of Pyrolyzer onto your GC, an optional installation kit specially designed for your 
GC is required. 
In this chapter, procedures for installation onto Shimadzu GC-2010 are described as an example.  
See the instruction manual that comes with the Installation Kit for installation onto GC-17 or other 
GCs. 
 

3.3.1 Contents of Shimadzu GC-2010 Installation Kit (P/N: PY-S2010) 
 

The installation kit contains the following parts A~F (Fig. 3.2). 
 
A. Carrier gas tube set (for connecting a carrier gas source to Pyrolyzer) 
B. GC-2010 mounting stand (for mounting Pyrolyzer on the GC injection port) 
C. Septum cap set (when Pyrolyzer is used, use the septum cap set contained in the kit) 
D. Adsorption trap set (this is connected to the split vent outlet) 
E. Remote signal cable (for connecting GC Ready and GC Start signals) 
F. Type G socket set (when Pyrolyzer is used, this is used as a cap nut for the carrier gas 

line) 
G. Instruction manual 
 
 

Fig. 3.2 Contents of Installation Kit for Shimadzu GC-2010 

Fig.1  Carrier gas tubing set 
   （PYS-1713） 

Fig.2  Stand 
   （PY1-3851） 

Fig.3 Septum cap set 
   （PYS-1722） 

Fig.4 GM plug 
   （PYS-1721） 

A 

B

C 

A B C 

A B 

Fig.5  Trap 
   （PY1-2227） 

Fig.6  Remote signal cable 
   （PY1-5926） 

B 
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3.4  Installation Procedure 
 
STEP 1  Installing adsorption trap (Figs. 3.3 and 3.4) 
 
Disconnect split vent tube and connect the adsorption trap. 

 

 

 

 

Septum purge 

Carrier gas 

Split vent 

Marked “C”

“Marked “S” 

Marked “P” 

Connection

Connection of split gas plumbing

Fig.3.3 Before modification of carrier gas plumbing 

Fig.3.4 Modification of carrier gas plumbing and the absorption 
trap installation  

Connect to Pyrolyzer (Carrier IN)

Split vent Absoption trap 

Plug with type G socket 



    3-5  
Ver .S2.02 -03 

STEP 2  Modifying carrier gas flow path (Figs. 3.3 and 3.4) 
 
1. Disconnect the carrier gas line at the connectors enclosed in circle in Fig. 3.3  

(Indicated by “C”) and attach Type G plug (cap nut) to the tube from the injection port, using 
3 pieces of aluminum packing together (F (b) of Fig. 3.2). 
 

2. Connect the stainless steel pipe contained in the carrier gas tube kit (F (a) in Fig. 3.2) to the 
carrier gas line just disconnected.  Connect this stainless steel pipe to the carrier gas inlet of 
Pyrolyzer using a 1/8” union and a rubber stopper with a hole. 

 
 
STEP 3 Replacing septum caps (Fig. 3.5) 
 
Replace the septum cap, needle guide, and septum of GC-2010 with contents of the septum cap 
set in the kit. 
 

 
STEP 4  Attaching Mounting Stand (Fig. 3.6) 
 
Secure the mounting stand onto the injection port using two screws that fix the injection port. 

Fig.3.5 Replace septum caps  

Septum cap 

Needle guide 

Septum 

Standard For Pyrolyzer 

Red 

Fig. 3.6 Fixing mounting stand 

Setscrew

Setscrew 
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STEP 5  Removing the stainless steel protective tube in the Pyrolyzer (Fig. 3.7) 
 

The stainless steel protective tube that was used for transportation is removed. 
 
1. Unpack Pyrolyzer from the package and remove the protective mesh cover. 
2. Remove storage stand from the Pyrolyzer by loosening four screws located on both sides at 

the bottom of the Pyrolyzer. 
3. Remove the ITF heating block. 
4. Loosen the nut that secures the protective tube at the bottom of the Pyrolyzer; then loosen 

the quartz tube securing nut located at the top.  The tube can now be pulled out downward. 
 
<<Do not completely remove the quartz tube securing nut at the top.  Just loosen it instead. 
This will prevent the O-ring from coming off and make insertion of the quartz tube easier. >> 
 

 

Fig.3.7 Removing protective tube 

Strage stands 

Slit Screws (two on both side) 

 
Quartz tube securing nut 

Protective tube 

Securing nut 
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STEP 6  Attaching quartz tube and ITF needle to Pyrolyzer  
(Figs. 3.8, 3.9 and 3.10) 

A mastery of this procedure is recommended because this is required in daily maintenance 
routine. 

1. Attach ITF needle to the ITF union using a 1/16” nut.  After hand tightening, it must be 
further tighten by 1/8 turn using a wrench. (Fig. 3.8) 

2. Insert the quartz pyrolysis tube from the bottom of the pyrolyzer.  Start inserting the tube end 
with larger inner diameter while holding the bottom end and gently turning the tube, until it 
hits the sampler stand nut at the top of the Pyrolyzer (Figs. 3.8 and 3.9).  

3. Hand tighten the quartz pyrolysis tube securing nut at the top.  At this point, 1~2mm of the 
bottom end of the quartz tube should be sticking out from the bottom of the Pyrolyzer (Fig. 
3.10). 

4. Insert a graphite Vesper ferrule at the end of the quartz tube and hand tightens the ITF union 
(Fig. 3.8). 

5. From the top of the pyrolyzer gently push down the pyrolysis tube with the tip of a supplied 
wrench (12mm) and continue pushing the quartz tube down until it hits the ITF union (Fig. 
3.9).  The presence of dead space between the bottom of the pyrolysis tube and ITF union 
results in peak broadening on the chromatograms. 

6. Using the supplied wrench tighten the ITF union by a 1/4 turn with a wrench. 

 

The maximum use temperature of Vesper ferrule mentioned 
above is 320°C. For higher temperatures use a graphite 
ferrule (P/N: PY1-7921) in the same manner.

WARNING 
The ITF needle at the bottom of the Pyrolyzer is sharp and may cause injury. 
When the Pyrolyzer is not in use, it should be stored with the storage stand 
attached.     

Fig3.9 Install quartz pyrolysis tube 

ITF thermal insulator

Heat sink adapter 

Quartz pyrolysis tube

Push down the quartz 
pyrolysis tube with 
supplied hex screwdriver.

Fig.3.8 Quartz pyrolysis tube and ITF needle 

Graphyte ferrule 
（P/N:PY1-7911） 

ITF needle 
(P/N:PY1-1174) 

Interface union set 
（P/N:PY1-3510） 

ITF union 
(P/N:PY1-3511) 

Metal ferrule

Quartz Pyrolysis tube 
(P/N:PY1-2018) 
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STEP 7 Gas leakage check (Fig. 3.10) 
 
Gas leakage check is performed before installing Pyrolyzer onto GC. 
There are four plausible locations in the Pyrolyzer where gas leakage can occur (Fig. 3.10). 
 
a) O-ring at the joint of the quartz pyrolysis tube and the sampler stand. 
b) O-ring at the top of Pyrolyzer. 
c) Ferrule at the bottom of Pyrolyzer. 
d) Metal ferrule at the ITF needle. 
 

Pressurized Gas Leakage Tests: 
1. Connect the carrier gas tube to the Pyrolyzer. 
2. Drive the ITF needle into a septum to plug the needle opening, and then apply a gas 

pressure. 
3. Perform tests of gas leakage using a leakage detector at the locations, a)~d) listed above.  
 

If there is no gas leakage, gas releasing sound will be heard when the septum is removed 
from the needle.  If the quartz pyrolysis tube is broken, the leakage detector may not be 
able to detect the leakage. 

 

 
 
 
 

NOTE: Snoop may be used as a gas leakage detector, but it can cause the 
insulation failure of the furnace heater.  Therefore, use it with a special care not to 
allow the liquid to get into the furnace heater. 

Fig.3.10 Possible locations of gas leakage

（ b ） Upper part 

of quartz pyrolysis 

tube 

（ c ） Lower part of 

quartz pyrolysis tube 

（ d ） ITF needle 

connection 

（a）Sampler base 

（e）septum 

1～2mm sticking out from the bottom

 
Back ferrule 

O-ring 

Nut 
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STEP 8  Heat sink adapter installation (Fig. 3.11) 
 

Insert the heat sink adapter on to ITF block as shown in Fig.3.11 and fix it with the supplied 

1.5mm hex-driver. The slit should face to backward of the furnace for easy accessing to both 

of two fixing screws. When interface union accommodate to Auto-shot sampler is used, the 

slit of the heat sink adapter can lead the 1.6mm tube from the union. The clearance between 

ITF block and the heat sink adapter should be minimized to provide the best performance. 
 
 

Fig. 3.11 Heat sink adpter installation

Heat sink adapter 

Interface block 

Interface union Fix with screw

1.6mm tube from 
the interface union 
accommodate to the 
Auto-Shot Sampler

1. Insert the heat sink from the bottom  2. Minimize the clearance between 
interface block and the heat sing adapter

3. The interface union accommodate to Auto-Shot 
Sampler is used, the slit of the heat sink 
adapter can lead the 1.6mm tube from the 
union. 

Minimize the 
clearance here.
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STEP 9 Attaching ITF thermal insulation cover (Fig. 3.12) 
 
Once gas leakage tests are finished, put the ITF thermal insulation cover back in place. 
Then attach the ITF thermal insulation cover and secure it with screws. 

 

STEP 10 Mounting Pyrolyzer (Fig. 3.13) 
  

(1) Allow the ITF needle to pierce straight into the GC injection port by lowering the Pyrolyzer.  
At this point, bottom four screws on both sides are engaged into the slots of the mounting 
stand seated on the GC (Fig. 3.12).  Then tighten all four screws using the supplied Allen 
wrench, making sure that the Pyrolyzer stands in the upright position with keeping the 
sampler base in a horizontal position (recommended to use the level vial contained in the part 
box).  
 

 
(2)  Run the carrier gas and check the column pressure. 

 

 

Fig.3.12 Mounting pyrolyzer

Screw 

Mounting stand 

PY 

Slit 

ITF needle 

ITF thermal insulator 

Sampler base 
Level vial 
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STEP 11  Connecting control cables (Figs. 3.13 and 3.14) 
 
Connect Pyrolyzer control cables to the connectors labeled as “POWER” and “SENSOR” located 
on the back panel of the Temperature Controller.  Also connect ground wires to ground 
terminals. 
 

 

STEP 12 Connecting cooling gas line to Pyrolyzer (Figs. 3.13 and 3.14) 
 
Connect the Nylon tube from Electro Magnetic (EM) valve located on the back panel of the 
Temperature Controller (AIR OUT) to the cooling gas inlet tube (COOLING GAS) from the 
Pyrolyzer. 
 
STEP 13 Connecting remote signal cable (Figs. 3.13 and 3.14) 
 
1. Connect the connectors labeled “GC START IN” and “GC READY” of the supplied remote 

signal cable to the connectors labeled “START IN” and “READY” of GC-2010, respectively. 
 
2. Connect the other end of the cable to the connector labeled “GC REMOTE” at the rear panel 

of the Temperature Controller. 
 

 

Fig. 3.13  Connection Scheme of Double-Shot Pyrolyzer PY-2020iD, Temperature Controller, and GC 

Cooling gas source 

Back of the Pyrolyzer Back of the temperature controller 

Nylon tube

1/8” swagelok

Union 

Remote signal cable 
GC READY and GC 
START 

Cooling gas 
control valve

GC Back Plane 

“Air (In)”Pyrolyzer control 
Cable (heaters and 
sensors) 

RS-232C cable

PC Back Plane
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STEP 14 Reversing polarity of GC READY signal 
 
Hit [FUNC] key of GC-2010 and select “6. Setups”. Then select “9. Other Setups” to display 
“Other Setup Screen”. Choose “Close” at “Ready Signal Polarity”. 
 

 
 
 
 
 
 
 

 

NOTE 
When GC-2010 is used with other peripheral devices such as Auto Sampler, 
Head Space Sampler, etc., the polarity of READY signal must be changed so 
as to comply with the specific device used. See the instruction manual for 
details. 

Fig. 3.14 Back Panel of Temperature Controller 
            

Cooling gas EM Valve 

PC control port  

Remote control cable connector
(Connected to GC) 

Main power breaker  
(Center button jut out if abnormal) 
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Printer port 
(Used to print settings) 
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Non Fuses breaker for heaters 
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VALVE 

RS232C 

PRINTER

GC-REMOTE 
POWER 
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STEP 15 Connecting PC to Temperature Controller 
1. Using an RS232Ccable, connect a serial port of PC (COM1~COM8) to “PC control port” located at 

the back of Temperature Controller. 

2. If Auto-shot Sampler (AS-1020E) is used, connect a serial port of PC (COM1~COM8) to a port 

located at the rear of the Auto-shot Sampler with an RS232C cable. 

 

STEP 16 Installation of Software 
1. Insert “PY-2020iD / iS control software” CD ROM to the CD drive of your PC. 

2. Setup program automatically starts and follow the instructions. Find the password at the back of 

the CD-ROM jacket. 

 
STEP 17 Setting COM Port 
If used in Windows NT environment, follow the procedures below to set the COM port. 

1. Select “Start” > “Settings” > “Control Panel” > “Ports” from the Windows task bar. A port selection 

screen will be displayed. 

2. Select a port to use and click “Settings” button to show the setting screen for the port selected. 

3. Click “Advanced” button to display a screen for advanced settings. 

4. Uncheck “FIFO” check box, then click “OK” button. 

5. Restart Windows NT. 
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CHAPTER 4 USING PY-2020iD CONTROL SOFTWARE 
 
4.1 STARTING PY-2020iD AND SCREEN LAYOUT 
 

4.1.1 Starting Up 
From the Start menu, Select “Program” > “PY-2020iD Control”.  After a splash 

screen (Fig. 4.1) is displayed for a short time, the main screen (Fig. 4.2) is 

displayed. 

 

 

 

Fig. 4.1 Splash Screen of PY-2020iD 

Fig. 4.2  Setting Screen of Single-Shot 
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4.1.2 Main Screen 

Fig. 4.3 shows the main screen of the PY-2020id control software. 

 

 

A. Title bar:  Shows method currently used. 

B. Menu bar:  Access to options and submenus. 

C. Tool bar:  Shows icons for functions. 

C-1:   Selects Single-Shot Analysis. 

C-2:   Selects Double-Shot analysis. 

C-3: `  Selects Direct EGA Analysis. 

C-4:   Selects Heart-Cut EGA Analysis. 

D:   Shows analysis mode currently selected. 

Fig. 4.3 Main Screen 

A. Title bar 
B. Menu bar C. Tool bar 

H. Status bar 

D 

E. Pyrolyzer setting 

F. Accessories settings 

J. Monitor 

G. Comments 

I. Program Start/Stop Button 

J-1
J-2

J-3

J-4

J-5

J-6

J-7 J-8

C-1 C-2 C-3 C-4 

E-1 

E-2 
E-3 

E-4 
E-5 

E-6 

F-1 

F-2 
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E. Pyrolyzer setting: Sets parameters for Pyrolyzer. This area depends 

on analysis mode selected. 

E-1:  Turns On/Off of Pyrolyzer heater. Checking the box 

turns heater on. 

E-2:   Sets Pyrolyzer temperatures. 

E-3:  Sets time for automatic control of Selective Sampler      

 or MicroJet Cryo-Trap. Upon starting this program, 

 Selective Sampler performs sampling during the 

 period set here. MicroJet Cryo-Trap operates during 

 the time defined here. 

E-4: Turns On/Off of interface heater. Checking the box 

turns heater on. 

E-5:   Sets interface temperature. 

E-6:  Selects a mode of interface control. If “Manual” is 

 selected, temperature is controlled to the 

 temperature defined in E-5. If “AUTO” is selected, it 

 is controlled to 100°C above the Pyrolyzer furnace 

 temperature, however, the temperature set in E-5 is 

 the upper limit temperature. 

F. Accessories setting:  Sets parameters for Selective Sampler and 

 MicroJet Cryo-Trap. Appearance of this area 

 depends on analysis mode selected. 

F-1:  Select a control mode of Selective Sampler. Check 

 this box, if automatic control is desired. Uncheck it 

 for manual mode. 

F-2:  Select a control mode of MicroJet Cryo-Trap. Check 

 this box, if automatic control is desired. Uncheck it 

 for manual mode. 

G. Comments:  Used to write down notes for each analysis mode. 

H. Status bar:  Shows the progress of the program. 

I. Start/Stop button Used to start or stop the program. 
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J. Monitor:  Shows operating conditions of each device 

connected. 

J-1:  Shows current temperature of Pyrolyzer. 

J-2: Shows set temperature of Pyrolyzer or final 

temperature of the heating program. 

J-3:  Shows current temperature of the interface. 

J-4:  Shows set temperature of interface. 

J-5:  Shows the region currently being sampled in 

Heart-Cut EGA Analysis. 

J-6:  Shows trap temperature of Micro jet CryoTrap. 

J-7:  Shows the elapsed time of Pyrolyzer being run. 

J-8 Shows time required for Pyrolyzer to complete the 

operation. 
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4.2 BEFORE STARTING ANALYSIS 
Before starting analysis, set interface temperature and its control mode; and tell 

the system what Pyrolyzer’s accessories (Selective Sampler and/or MicroJet 

Cryo-Trap) are used according to the procedure shown below. 

 

4.2.1 Setting Pyrolyzer’s Accessories 

4.2.1.1 Selecting accessory devices used. 
1. Select “Tools” > “Instrument Set up”. A screen shown in Fig. 4.4 is 

displayed. 

2.   If any of the accessory devices is used, check the box to indicate the 

device used. 

3. Select a carrier gas (atmosphere gas) used to heat the sample as shown 

in Fig. 4.4 A. Helium is normally used. If air is used, refer to section 4.2.1.2 

of this manual. 

4. Click “Use as Default Value” to make the current settings default. 

5. Click “OK” to end. 

 

 

 

Fig. 4.4  Setting Accessory Devices

A 
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4.2.1.2 Using Air as atmosphere gas 

 In this analysis, the sample is first heated in air, then the carrier gas is 

switched to helium to purge the column and detector. If automated analysis is 

desired, MicroJet Cryo-Trap (MJT-1030E), Selective Sampler (SS-1010E) and 

Carrier Gas Switcher (CGS-1050E) are required. Shown below describes the 

operation using these devices. Manual operation requires in-depth professional 

knowledge and extensive experiences. 

1. As shown in Fig. 4.5, check the boxes for MicroJet Cryo-Trap and 

Selective Sampler. 

2. Choose Air as shown in Fig. 4.5 A 

 

 

 

3. “He Purge Time” in Fig 4.5 B is the time it takes to replace all the all the 

Helium with Air. Normally default value (2min) is used. 

4. “Air Purge Time” in Fig 4.5 C is the time it takes to replace all the Air in 

column and detector with Helium when heating of a sample has been 

completed. In particular, if a mass spectrometer is used as a detector, all 

the air in the mass spectrometer must be replaced before turning on the 

filament. If this is the case, use default value of 20min. 

Fig. 4.5  Setting Selective Sampler 
(Air Used as Atmosphere Gas) 

B C 

A 
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4.2.2 Setting Interface Temperature 

Auto mode and Manual mode are available for setting interface temperature. In 

Auto mode, the interface temperature is automatically controlled according to 

the temperature of Pyrolyzer furnace, on the other hand, in Manual mode, it is 

controlled at a set temperature. Modes are selected in E-6 of Fig. 4.3. Usually it 

should be set to Auto mode. If Manual mode is selected, the temperature is 

controlled to a constant temperature determined by the value set in E-5 of Fig. 

4.3. In Auto mode, it is controlled 100°C above the temperature of Pyrolyzer 

furnace, but the interface temperature defined in E-5 is the upper limit 

temperature. As an example, relation between temperature of Pyrolyzer 

furnace and interface is shown in Fig. 4.6 where Auto mode is selected in E-6 

and the temperature is set to 300°C in E-5; and the Pyrolyzer furnace is heated 

from 50°C to 500°C.The interface initial temperature is automatically set to 

150°C, and the temperature rises up to the upper limit temperature of 300°C, 

100°C above the Pyrolyzer furnace temperature. 

Pyrolyzer furnace initial temperature (50°C)

Interface upper limit 

 temp. (300°C) 

100°C 

°C Pyrolyzer furnace temperature 

Time

Interface temperature 

Interface initial temperature (150°C)

Fig. 4.6 Interface Temperature in Auto Mode 
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4.3 SETTING ANALYTICAL MODES AND OPERATIONS 
 
4.3.1 Settings for Single-Shot Analysis and Operation Example 
Choose “Tools” > “Analytical Modes” > “Single-Shot Analysis” or click the tool 

bar icon of Single-Shot Analysis (A). A screen shown in Fig. 4.7 is displayed. 

 

Fig. 4.7 Setting Screen of Single-Shot Analysis

B 

C 

F 

A D 

E 
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1. Check the Furnace check box (B) to turn on Pyrolyzer heater. 

2. Type in Pyrolyzer furnace temperature in C, and allow it to stabilize. 

3. Enter a desired time in D. Once the program starts, the Selective Sampler 

stops sampling after the time defined in D has past. Then MicroJet 

Cryo-Trap stops cooling and GC ready signal is issued. (Actual pyrolysis 

time is within several milliseconds.) 

4. To auto control the Selective Sampler and/or MicroJet Cryo-Trap, check 

boxes in E and/or F. 

5. Place a sample in a sample cup and attach it to the Pyrolyzer. Once the 

sample cup is in place, in order to purge the dead space, allow 2min before 

proceeding to the next step. [If a double-shot sampler is used in 

Single-Shot mode, hold the top of the sampler and lower it until it hits the 

single-shot position. 

6. Click “START” button. 

7. A dialog box shown in Fig. 4.8 is displayed indicating that GC, Pyrolyzer, 

Interface, Selective Sampler, and MicroJet Cryo-Trap are all ready. 

Manually press the sample drop button of the Pyrolyzer to drop the sample 

cup, then immediately click “START” button of the dialog box or hit 

“ENTER” of the keyboard. 

Fig. 4.8 Dialog Box Showing Start of Single-Shot Analysis 
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4.3.2 Setting Double-Shot Analysis Mode and Operation 
Choose “Tools” > “Analytical Modes” > “Double-Shot Analysis” or click the tool 

bar icon for Double-Shot Analysis (A). A screen shown in Fig. 4.9 is displayed. 

 

 

1. Check the Furnace check box (B) to turn on Pyrolyzer heater. 

2. To auto control the Selective Sampler and MicroJet Cryo-Trap, check 

boxes in C and D. 

3. Enter parameters in E through K. 

4. Place a sample in a sample cup and attach it to the Pyrolyzer. [In 

Double-Shot technique (combination of thermal desorption and pyrolysis), 

to purge the dead space, loosen the purge knob shown in page 1-4 then 

tighten it back after 3 minutes. During this period, GC may generate 

warning sounds if the carrier gas is controlled by EPC, but if it is within 5 

min, GC will stay turned on (Agilent6890, Shimadzu GC-17A.) 

5. Click “START” button. 

 

A

B 

C 

D 

E Initial temperature 

  (40~800°C) 

F Hold time at initial temp. 

  (0~999.9min) 

G Heating rate 

  (0~100°C/min) 

H Final temperature

    (40~800°C) 

I Hold time at final temperature 

      (0~999.9min) 

J Pyrolysis temperature 

 (40~800°C) 

K Hold time at pyrolysis 

  (40~800°C) 

Fig. 4.9 Setting Screen of Double-Shot Analysis 
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6. A dialog box shown in Fig. 4.10 will be displayed, if GC, Pyrolyzer furnace, 

interface, Selective Sampler, and MicroJet Cryo-Trap are ready. 

 

7. Manually lower the double-shot sampler located at the top of the Pyrolyzer to 

introduce the sample cup to the Pyrolyzer furnace. Immediately following this, 

click “START” button of the dialog box or hit “ENTER” key on the keyboard. 

[Thermal desorption sequence will be started.] 

8. When thermal desorption program is completed, a dialog box shown in 

Fig.4.11 will be displayed. Pull up the double-shot sampler slider so that the 

sample cup is positioned just underneath the sampler. After the column inlet 

pressure has been stabilized, click “YES” button. [GC will start and the 

pyrolyzer furnace temperature will rise up to the temperature set in I of Fig. 

4.9. 

 

9. Thermally desorbed components are analyzed by GC. When analysis is 

completed, GC oven will be cooled down to the initial temperature. 

10. A dialog box shown in Fig. 4.12 will be displayed when GC oven 

temperature cools down to the initial temperature and GC issues a ready 

signal. Immediately after manually pressing the sample drop button of the 

Pyrolyzer, click “START” button of the dialog box or hit “ENTER” of the 

keyboard. 

Fig. 4.11 Dialog Box Showing End of Desorption in 
Double-Shot Analysis 

Fig. 4.10 Dialog Box Showing Start of Desorption Program 
in Double-Shot Analysis 
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Fig. 4.13 shows schematic diagram of a series of operational events described 

above.  

Fig. 4.12 Starting Pyrolysis in Double-Shot Analysis

Fig. 4.13 Sequence Program in Double-Shot Analysis 

Initial (min) Final (min)

PY

Initial (°C) 

Final (°C) 

Pyrolysis (°C) 

Rate（℃/min） 

DESP 

Auto cooling 

Initial (min)

OFFONOFFON 

START 

MicroJet 

END 

A dialog box (Prepare for NEXT STEP?) is 
displayed.  
 
If pyrolysis is to be done, pull up the double-shot 
sampler all the way, then click “Yes” button, 
causing the GC to issue a start signal. 

If GC is ready, a dialog box (READY for Pyrolysis) 
is displayed. 
 
As soon as the sample cup is dropped, click 
“START” button, causing the GC to issue a start 
signal. 

A dialog box (READY FOR Desorpton) is displayed.  
 
Click “START” button, immediately after the sample cup is dropped 
into the pyrolyzer furnace. GC does not issue a start signal at this 
point. 
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4.3.3 Setting for Direct EGA Analysis and Analytical Procedures 

This analytical mode is used for Evolved Gas Analysis as well as for normal 

multi-step thermal analysis. If “Heart Cut EGA Analysis”, described in the next 

section, is performed, an EGA curve of a sample is obtained in advance in this 

analytical mode. Using the Selective Sampler (optional), you can sample out 

any of the temperature zones of the resultant EGA curve and analyze it by GC 

all in automated fashion. Before analysis, install an EGA capillary tube (part 

No.: UADTM-2.5N) into your GC, in place of a separation column, and set the 

GC oven temperature to 250~300°C. 

 

1. Choose “Tools” > “Analytical Modes” > “Direct EGA Analysis”, or click the 

tool bar icon for Direct EGA Analysis (A). A screen shown in Fig. 4.14 is 

displayed. 

 

2. Check the box of Furnace to turn on the Pyrolyzer heater. 

3. Check the box of Selective Sampler (C), if automatic control is desired. 

4. Enter parameters for Step 1 of heating program in D through H. 

A

B 

D Initial temp. 

E Hold time at initial F Heating G Final temp.

C 

H Hold time at final 

Fig. 4.14 Setting Screen of Direct EGA Analysis 
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5. Enter parameters for Step 2 of heating program. Entering “0” for Rate 

(°C/min) in subsequent spaces will prohibit executions of the steps and 

beyond. Fig. 4.15 illustrates an example of 4-Step heating program. 

 

 

6. Place a sample in a sample cup and attach the cup onto the Pyrolyzer. 

Wait 2 minutes before proceeding further in order to purge the dead space. 

7. Click “START” button. 

8. A dialog box shown in Fig. 4.16 will be displayed when GC, Pyrolyzer, 

interface and Selective Sampler are all ready. Immediately after dropping 

the sample cup into the Pyrolyzer furnace, click “START” button of the 

dialog box or hit “ENTER” key of the keyboard. 

 

Fig. 4.16 Dialog Box Showing Start of Direct EGA Analysis 

Fig. 4.15 EGA Multi-Step Program 
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4.3.4 Setting for Heart-Cut EGA Analysis Mode and Procedures 
A Selective Sampler (optional) is required for this analysis mode. If low boiling 

components below C15 are to be analyzed, a cooling trap is also required. 

Frontier Lab’s MicroJet Cryo-Trap is recommended. 

In Heart-Cut EGA Analysis, based on evolved gas curve (EGA curve) obtained 

by Direct EGA Analysis, whether each zone range (elution time) can be 

sampled or not is determined, and sampling zones are automatically introduced 

into a GC for analysis using a Selective Sampler. An analysis example in which 

EGA curve of a ceramic composite material obtained by heating it from 100 to 

600°C (20°C/min) is shown in Fig. 4.17. 

 

1. Choose “Tools” > “Analytical Modes” > “Heart-Cut EGA Analysis” or click 

the Heart-Cut EGA Analysis icon in the tool bar. A screen shown in Fig. 

4.18 will be displayed.  

2. Check the box of Furnace (B) to turn on the heater of Pyrolyzer. 

3. Check the box of Selective Sampler (C) and Micro Jet CryoTrap (D), if auto 

control is desired. 

4. Type in parameters for heating program in the table marked by E similarly 

in the manner of Direct EGA Analysis. 

5. Determine the end time of each zone from the EGA curve in Fig. 4.16, and 

type in the number in F. (Using an MS as a detector and looking at the 

mass chromatogram, elution temperatures of target components are easier 

to determine.) [Final (min) of each zone is automatically entered in Initial 

(min) of the previous zone. Initial of Zone A starts from 0.0min (fixed). Initial 

(°C) and Final (°C) are automatically calculated and displayed.] 

Fig. 4.17 EGA Curve of Ceramic Composite Material 

Time (Temp)
10 18 23 30 min 0 

B C DA

t１ t2 
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6. If Zone A is to be sampled, check the box of G. 

7. To sample Zone B through D, check the corresponding boxes as in the 

case of Zone A. 

8. Place a sample in a sample cup and install it onto the Pyrolyzer. Wait 2 

minutes before proceeding further to purge the dead space at the 

connection. 

9. Click “START” button. 

10. A dialog box shown in Fig. 4.19 will be displayed if GC, Pyrolyzer, interface 

and Selective Sampler are all ready. Manually press down the double shot 

sampler located at the top of the Pyrolyzer to introduce the sample cup into 

the pyrolyzer furnace. Immediately after this, click “START” button in the 

dialog box or hit “ENTER” key of the keyboard. 

 

Fig. 4.19 Dialog Box Showing Start of Heart-Cut EGA Analysis 

C 

D 

E 

G 
A 

B 

F 

Fig. 4.18 Setting Heart-Cut EGA Analysis Mode
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4.4 OTHER FUNCTIONS 
 

4.4.1 Saving and Loading Analysis Parameters 
  Analysis parameters can be saved with a filename. When all the setting are 

completed, choose “File” > “Save As” and type in a filename to save the 

settings in a file. To overwrite a file with the current file, select “File” > “Save”. 

 

4.4.2 Testing Valves and Calibration of Pyrolyzer Furnace Temperature 
  Choose “Tools” > “Maintenance”. Fig. 4.20 will be displayed asking for a 

password. Type in “2020” and click “OK”. A screen shown in Fig. 4.21 will be 

displayed. 

 

 

Fig. 4.20 Entering a Password 

Fig. 4.21 Calibration of Pyrolyzer Furnace Temperature and Tests of Valves 

A B 

C D
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4.4.2.1 Calibration of Pyrolyzer Furnace Temperature 

Calibration of Prolyzer furnace temperature can be done by entering a 

temperature actually determined by other thermometer. Because the Pyrolyzer 

furnace temperature greatly influences analytical results, you should 

familiarize .yourself with the operations prior to proceeding further. 

1. Make sure that the pyrolyzer furnace temperature is well stabilized at the 

set temperature. The set temperature is shown in A,  but this is 

automatically entered with a temperature defined in Single-Shot Analysis. 

Calibration must be done at temperatures between 100 and 700°C.  

2. Type in actually determined temperature in B, using a thermometer of your 

choice. 

3. Click “SAVE” to complete the calibration. 

4. Make sure that the temperature displayed matches the actual temperature 

reading. If not, repeat the operations (1) thorough (3) described above. 

 

4.4.2.2 Manual Tests of Valves 
Operations of valves can be tested by manually turning ON and OFF each 

valve (EM valves of cooling air for pyrolyzer, Selective Sampler, and MicroJet 

Cryo-Trap). Closing the screen shown below will bring each valve back to 

normal operation. 

 

4.4.2.3 Setting Upper Limit of Accumulated Number of Runs 

Enter a value for the upper limit of accumulated number of runs (C in Fig. 4.2.1). 

When the accumulated number of runs reaches this value, a message advising 

you to perform maintenance of the system is displayed. If so, maintenance 

should immediately be performed. After it is finished, click Clear button (D in Fig. 

4.21) to reset it. The default value is 3000. 
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4.4.3 Printing Settings 

Settings in the currently loaded file can be printed. Choose “File” > “Print”. An 

example of print out is shown in Fig. 4.22. 

 

Heater Control
 Furnace : ON
 Interface : ON
 Interface Auto Control : ON
 Interface Temperature (°C) : 320

Accessories
 MicroJet Cryo-Trap : ON
 Selective Sampler : ON
 

Auxiliary : ON

Accessories Auto Control
 MicroJet Cryo-Trap : ON
 Selective Sampler : ON

Monitoring Display Interval (sec) : 1

Keyboard Lock : ON

Single Shot Analysis
 Pyrolysis Temperature (°C) : 600
 Initial Time (min) : 0.20

Double Shot Analysis
Desorption Program
 Initial Temperature (°C) : 40
 Initial Time (min) : 0.50
 Rate (°C/min) : 20
 Final Temperature (°C) : 250
 Final Time (min) : 2.00

Pyrolysis Program
 Pyrolysis Temperature (°C) : 600
 Initial Time (min) : 0.20

Direct EGA Analysis
1st
 Initial Temperature (°C) : 40
 Initial Time (min) : 1.00
 Rate (°C/min) : 10
 Final Temperature (°C) : 250
 Final Time (min) : 2.00
2nd
 Rate (°C/min) : 20
 Final Temperature (°C) : 600
 Final Time (min) : 2.00
3rd
 Rate (°C/min) : 0.00
 Final Temperature (°C) : -
 Final Time (min) : -
4th
 Rate (°C/min) : -
 Final Temperature (°C) : -
 Final Time (min) : -

Heart Cut EGA GC Analysis
 Zone A (min, °C) : 0.00-3.00, 40-40
 Zone B (min, °C) : 3.00-11.00, 40-260
 Zone C (min, °C) : 11.00-18.00, 260-280
 Zone D (min, °C) : 18.00-55.50, 280-700

Method Information : This Method is Default. 

Method File Name : Default.py
Created : 7, Apr, 1999 17:35:25
Modified : 24, Sep, 1999 10:15:04

Analytical Method Information

Date:
Sign:

Fig. 4.22 Printing Settings 
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4.4.4 Setting Communication Speed 

This is provided to help resolve problems involved in the communication 

between your PC and temperature controller of the Pyrolyzer. To change 

communication speed between PC and the temperature controller, choose 

“Tools” > “Options”. Fig. 4.23 is displayed. Select a time (sec) and click “OK”. 

2sec is normally used. 

 

 

 

 

 

 

 

 

 

 

 

 

4.4.5 Setting Timer for Pyrolysis Furnace Temperature by Py Conditioning Table 
Select [Tools] – [Py Conditioning Table]. Timer setting table is displayed (Fig. 

4.24). Enter desired date and time, pyrolysis furnace temperature, and interface 

temperature. Hit the Run button to activate the timer. In an example in Fig.4.24, 

at 6:00am of June 1, 2003, pyrolysis furnace temperature will be 700°C and 

interface temperature will be 320°C. On the same day at 7:00am, the pyrolysis 

temperature will be 40°C and interface temperature will be 140°C. 

 

Fig. 4.23 Setting Communication 

A 

B 

C 

Fig. 4.24 Setting Timer in Py Conditioning 
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A

Furnace 

Fig. 5.1 Contamination     
and Cleaning 

CHAPTER 5  MAINTENANCE 
 

A pyrolysis GC system is largely different from a GC alone system in that each component of 
the system is closely working with others and together forming a complete integrated system. 
The reliability of analysis results highly depend on the condition of each component device, 
therefore, daily and regular maintenance work is extremely important after installation. 

 
5.1 DAILY MAINTENANCE 
 

In daily operation, maintenance work required is cleaning of sample cups, quartz pyrolysis tube 
and interface needle. Consult the GC manual for the maintenance of your GC. 

5.1.1 Pyrolysis Furnace 
 
1. SAMPLE CUPS 

Disposable Eco-cup is highly recommended to use only once. Thereby there will be no need to 
pester with residues of previous sample. If you want to reuse them, physically remove all the 
residues in the cup with tweezers first. Then wipe the inner surface of the sample cup with 
cotton swab, soaked with solvent. In addition to that, stir the sample cups with just enough 
solvent to cover them. The cups should be well-dried before use. 

 
2. QUARTZ PYROLYSIS TUBES 

The degree of contaminations of the quartz tubes depends on 
how they are used.  Especially when a large amount of 
materials are pyrolyzed, the upper part of the tubing (A in Fig. 
5.1) is contaminated with high boiling species.  After cooling 
the furnace to room temperature the contaminations are 
removed by rubbing the inner wall of the tube with a cotton 
swab dampened with a solvent (Fig. 5.1). For a complete 
cleaning of the quartz tube, the tube must be removed from 
the assembly. Note1) Tough contaminations must be 
physically removed first, then cleaned by red-heating the tube 
with a burner while blowing air through the tube. 
 

3. INTERFACE NEEDLE 
Contaminations are mostly tars and stained tars. Contaminated needles are sonicated in a 
solvent to clean the inside. If this does not show improvements, replace them with new ones. 
Interface temperature (ITF TEMP) of 280 ~ 320ºC is recommended for daily operations. 

 

 

CAUTION 
When removing the quartz pyrolysis tube, it may be difficult to remove it as the interface union 
and quartz tube are stuck together. If this is the case, heating the union with a burner will help 
these come off. Vespel ferrule cannot be used. 
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5.1.2 GC Injection Port 
 
1. SEPTA 

When the pyrolyzer is installed onto a GC, the injection port is thermally protected by the 
interface cover; therefore, the temperature of the septum is higher by at least 50ºC than in GC 
alone operation, and this makes the silicon rubber septum susceptible to thermal degradation. 
Our experiences show that high quality septa will last about one month at injection port 
temperature of 300ºC. The use of supplied pretreated septum is recommended to allow facile 
removal of the septum at the next replacement (prevent the septum to stuck).  

 
2. INSERTS 

High boiling species from the pyrolyzates travel to the GC injection port via the pyrolyzer. If the 
injection port temperature is low, such species tend to deposit on the interface needle and on 
the glass insert. If this is the case, set the port temperature to 350ºC and allow it to bake for 2 
~ 3 hours with carrier gas on, but without the column installed. In the normal use check the 
insert inner wall every one to two weeks to see if there is contamination. 
 

3. COLUMNS 
The degradation of columns depends mainly on use conditions (analysis conditions) as well as 
the nature of pyrolyzates. Tars, reactive gases such as HCl from pyrolysis can degrade part of 
or sometimes the entire column. Generally tars are often too tough to remove completely by 
rinsing the column with a solvent, because tars are baked and bonded tightly to the inner wall 
of the column at high temperatures. If the degradation is made by strong acid gases such as 
HCl or HBr, the column cannot be restored to its original performance. If the sample is 
considered to generate these acid gases, put glass wool or filler coated with potassium 
hydroxide in the glass insert to protect the column from exposing to the acid gases. 
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5.2 REGULAR MAINTENANCE 
 
In addition to daily maintenance work, regular maintenance in every three to four months is 
recommended. This will ensure trouble-free operations. 

 

5.2.1 Pyrolysis Furnace 
1. COOLING FAN 

Check to see if the cooling fan starts spinning as soon as the temperature controller is 
powered on. If the cooling fan does not start immediately, the fan needs to be replaced. The 
cooling fan does an important role to keep the sample temperature near room temperature 
when the system is at stand by. 

 

2. LIQUID SAMPLER 
Replace the septum. There is no need to perform maintenance work, unless the sample is 
used daily, however, the septum should be replaced regularly to avoid unexpected troubles. 
 

3. DOUBLE-SHOT SAMPLER 
a) Make sure that the slider moves smoothly. If there is difficulty, move it up and down several 

times until it moves smoothly, or disassemble it to clean. 
 

b) Check the O-ring of air purge valve for any damage. This can lead to gas leakage. 
 

c) The mounting surface of the sampler is mirror finished. Contamination or scratches on the 
surface can result in gas leakages. When storing the sampler, the surface should be 
protected from scratches. 

 
d) Check to see if the cup chuck can securely hold the sample cup, and if pressing the release 

button can drop the sample cup.  If it fails, factory repair may be required.  Consult your 
local agent. 

  

4. SAMPLER BASE (sampler mounter) 
Contamination of an O-ring at the sampler base is the cause of gas leakage. Clean it by 
rubbing with a cotton swab dampened with methanol. Avoid using other solvents such as 
acetone, methylene chloride, etc. 
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5.2.2 Gas Chromatograph 
1. INJECTION PORT 
Upon extended use, the injection port split pipe tends to be clogged by tars. If this is the case, 
remove it from the GC and clean it by flushing with a solvent through it, then heat it by a burner 
while running a carrier gas through it. The pipe needs to be checked every three to four 
months of use. 
 
2. ABSORPTION TRAP 
If the acrylic wool in the trap tube at the outlet of the split/splitless injection port gets colored 
due to deposition of tars, replace it with a new trap tube loaded with activated carbon (Trap set, 
P/N: PY1-2216), or fill it with new activated carbon (60/80 mesh) and acrylic wool. Do not use 
glass wool for this purpose, as chips from the glass wool travel to valves and can lead to 
malfunction of the valves. 

5.2.3 Temperature Controller 
1. Make sure that connectors for heater power of pyrolyzer, temperature sensor, and 

temperature controller all have a good electrical contact. 
2.  Make sure that temperature controller is properly grounded. 

5.2.4 When Pyrolyzer is Not Used for a Long Time 
If the pyrolyzer is not used for extended period of time, the pyrolyzer removed from GC should 
be stored in a nylon bag, so that the cartridge heaters are protected from moisture. 
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CHAPTER 6  TROUBLESHOOTING 

Symptom, causes, and their solutions are summarized below. 

6.1  ABNORMAL PYROGRAM ( CHROMATOGRAM) 
 SYMPTOM CAUSE SOLUTION/CHECK POINTS 

1.1 
Gas leakage   

See Operation Manual 6.3 for details.  

Check GC injection port, detector, and 
column connection. 1. 

NO Peaks 
1.2 
No signal from GC detector Consult GC manual for solution. 

2.1 
Deteriorated column 

Replace with new one and perform column 
performance test using standard. 

2.2 
Abnormal diffusion Increase split-vent flow rate. 2. 

Broadened peaks 

2.3 
Pyrolysis temperature too low Increase pyrolysis temperature. 

3.1 
Deteriorated column Replace with new one. 

3.2 
Abnormal diffusion Increase split-vent flow rate. 3. 

Tailing peaks 
3.3 
Pyrolysis temperature too low 

Increase pyrolysis temperature. 

Recommended for cross-linked polymers 
(eg.550 to 650°C) 

4. 
High boiling species 
not eluting out. 

High boiling species 
smaller than 
expected 

Broadened high 
boiling species 
peaks 

4.1 
Interface or injection port temperature 
is too low  

Increase temperature (200 to 320°C) 

(Max septum temperature depends on GC 
used, but do not go beyond 320°C except 
when absolutely required.) 

5.1 
Residues from the previous runs stil l 
remain in the column 

Use Selective Sampler to l imit high boiling 
components to get into the column.  

Use column with higher temperature 
resistance and bake the column every time 
after use. 

5.2 
Broken pieces of septum in the insert  Clean the insert. 

5. 
Ghost peaks at high 
temperatures 

5.3 
Contamination in pyrolysis tube  See Operation Manual 5.1.1for details.  

6.1 
Deteriorated column 

Replace the column or check column 
performance using UA-5 column that is 
used in installation. 

6.2 
Tars in interface needle 

Clean or replace the needle.  

Increase the use temperature. 

6. 
Polar species not 
eluting out 

6.3 
Activated quartz tube due to 
deposition of inorganics. 

Clean or replace the tube. 
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 SYMPTOM CAUSE SOLUTION/CHECK POINTS 
7.1 
Gas leakage See Operation Manual 6.3. 7. 

Pyrogramas are not 
reproducible 

7.2 
Improper pyrolysis temperature 

Set it to optimal temperature. 

(Reproducibil ity depends on samples. 
Check the system with standard sample 
and UA-5 column) 

8. 
Septum residues 
remain when 
replacing septum 

8.1 
Over heated septum Surface treated septum is recommended 

9. 
Raised baseline at 
high temperatures 
in program 
operation (high 
background) 

9.1 
Liquid phase of column oxidized by air 

For Ultra ALLOY® columns 
(UA-1,UA-5,PY), clean the column with 2ml 
of methanol. Then bake the column in 
program mode <60°C (5min.) ~ 10°C /min 
~ 400°C (60min.) >. Do not connect the 
column end to the detector. For other 
columns, check with your dealers. 

10. 
Split peaks or 
abnormal peaks. 
Specially at about 
C20 

10.1 
Sample temperature from pyrolyzer is 
too high and sample cannot be 
trapped at the column head uniformly 

Fill the liner used in the GC injection port 
with fi l ler coated with 5% sil icon gum. Bake 
it thoroughly before use. Do not connect 
the column to the injection port. 
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6.2 PYROLYSIS FURNACE 
SYMPTOM CAUSE SOLUTION/CHECK POINTS 

1.1 
No carrier gas 

Check carrier gas source valve and pressure. 

Check total flow rate of carrier gas and 
assignment  of the injection port in use. 

Absence of a column on 
injection port or gas leakage at 
the connection of column 

Install a column. 

Check the column seal. 

Gas leakage at the septum 

Replace the septum with a new one. 

Gas leakage may occur at the septum when 
cooled the Interface of the Pyrolyzer and/or GC 
injection port after the run.  Interface and injection 
port temperatures are recommended to keep high 
at your operation temperature (PY temp. should 
not higher than 600ºC ) during the system is not in 
use. 

Absence or looseness of the 
plug cap on the carrier gas inlet 
pipe of the GC injection port 
GC 

Carrier gas inlet pipe of the GC injection port 
should be plugged with a supplied cap. (Refer 
Operation Manual page 3-3) 

The cap is not required when the carrier 
gas-switching valve is installed. 

Absence of sampler Sampler should be installed on the sampler base 
of the pyrolyzer. 

Looseness of the sampler or 
poor seal by foreign objects on 
O-ring.  

Clean the O-ring and/or contact surface of the 
sampler with a cotton swab dampened with 
methanol 

Looseness of the seal at the 
upper part of the quartz 
pyrolysis tube 

O-ring and metal washer should be used to seal 
this portion.  The metal washer is essential to 
prevent the O-ring to be twisted. Hand tightening 
will seal this portion sufficiently. 

Looseness of the interface 
union or worn out graphite 
vesper ferrule 

Securely tighten the union with a supplied wrench. 

Or replace a graphite vesper ferrule. 

Looseness of the interface 
needle or worn out metal ferrule

Securely tighten the needle nut. 

Or replace the interface needle. 

1.2 
Gas 
leakage 

Looseness of the SS adapter 

(When the SS-1010E is 
installed） 

Securely tighten the SS adapter (attached onto 
the outlet of the GC injection port). Or replace 
aluminum washer ( See SS-1010E Operation 
Manual 3-2). 

1. 
Cannot obtain column 
head pressure. 

1.3 
Clogged interface needle 

Replace the interface needle. 

Clogged interface needle may cause the following 
symptoms 

 Takes longer time to recover the column 
head pressure when install the sampler. 

 Column head pressure will go down slowly 
when the PY furnace is open to atmosphere 
(Normally, pressure dawns instantly) 

 The screw nut of the sampler is tighter than 
usual to loose it. And gas will blow out when 
loose the screw nut. 

2.1 
Gas leakage See 1.2 mentioned above. 

2. 
Column head pressure 
will not follow the 
column temperature 
program when constant 
column flow mode is 
used. 

2.2 
Total gas flow rate is not high enough to keep 
required column head pressure 

Set the total carrier gas flow rate more than 
50ml/min. 

When the gas saver is used, minimum total flow 
rate of carrier gas should add 10 ml/min to the 
value instructed in GC manual. Because the 
pyrolyzer always purges the dead volume of the 
sampler. 
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SYMPTOM CAUSE SOLUTION/CHECK POINTS 
3. 
Too tight to loose the 
screw nut of the 
sampler. And will blow 
out gas when loose the 
screw nut 

3.1 
Interface needle is clogged and the inner 
pressure became high  

Replace the interface needle. 

See 1.3 mentioned above. 

4.1 
Interface and/or GC injection port 
temperature(s)  is (are) too low 

Increase temperature.  

Max interface temperature is 320°C when 
graphite vesper ferrule is in use. 

Max septum temperature depends on GC in use. 
But do not set it beyond 350°C except when 
absolutely required. 

4. 
Interface needle is 
clogged frequently 

4.2 
Cooling point exists between the outlet of the  
quartz pyrolysis tube and the GC injection 
port because of improper Pyrolyzer 
installation  

Interface needle is completely covered by cover 
and not visible from outside when the Pyrolyzer is 
installed properly.  

5.1 
Over- tightens the interface union 

Excess force may results in breakage of the 
quartz pyrolysis tube, so work slowly. 

Hand-tighten the interface union first, and then 
rotate it by 60° ~ 90° with a supplied wrench. 

5. 
Quartz pyrolysis tube 
will be broken easily 
when the interface 
union is tightened. 5.2 

Some extra forces have shifted the furnace 
alignment.  

Extra force should not be needed to insert the 
quartz pyrolysis tube into the furnace.  If you feel 
difficulties in inserting the tube into the furnace, 
alignment of the heated blocks at the factory may 
be required. 

6. 
Stuck quartz pyrolysis 
tube and interface 
union 

6.1 
Stuck because of high temperatures 

Heat with a burner and try to take them apart. 
(Vesper ferrule is cannot be reused.) 

7. 
Column head pressure 
will dorp as the PY 
temp becomes high 
(e.g. Over 600°C) and 
will be recovered when 
the temperature 
becomes low. 

7.1 
Some extra forces have shifted the furnace 
alignment. 

The total alignment may be required at the factory.

8.1 
Gas leakage. See 1.2 mentioned above. 

8.2 
Fewer purge time after installing the sampler 
onto the furnace to start the run. 

Install the double shot sampler on to the furnace 
and wait to reach the column pressure at the set 
point. Loose the purge nut of the sampler to drop 
the pressure to atmosphere. Repeat this two times 
and close the purge nut.  Then wait more than 2 
min. before start the run. 

8. 
High background by air  
(MS is used) 

8.3 
Graphite (100%) ferrule is used at the 
interface union.  This ferrule will cause very 
small leakage and be unavoidable. 

The graphite vesper ferrule (P/N:PY1-7911) is 
recommended (ITF temp. should be set to below 
320°C). 

9.1 
Heater (s) concerned is (are) set to OFF 

Set it ON (See CHAPTER 4 in Operation Manual ) 

 9. 
Heated block(s) is(are) 
not heated 9.2 

Defective heater(s) Repair at the factory is required. 

10. 
Slow heating speed 
(PY) 

10.1 
One of the double heaters is defective Repair at the factory is required. 
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Causes of most troubles while using our pyrolyzer are gas leakage and clogged interface needle 
and showing the symptoms such as,  

• Bad reproducibility of pyrogram. 

• Insufficient column head pressure. 

<This symptom sometimes caused by less total flow rate of carrier gas. > 

• Lack of controlling carrier gas flow rate of GC under constant flow 
mode. 

<This symptom sometimes caused by less gas source pressure.  Verify appropriate gas source 
pressure> 

 
 
6.3   TYPICAL TROUBLE SHOOTING PROCEDURE 

1. Set the total carrier gas flow rate to 50ml/min. and the column head pressure 
to 40 ~ 60kPa（0.25mm id., 30m, MS is in use as the detector） 

2. Remove pyrolyzer from the GC injection port and connect carrier gas tube to GC 
injection port. Then make sure that the column head pressure reaches to the set 
pressure value. 

If the column head pressure does not reach to the set pressure value, following 
causes are possible. 
a Worn out or loose ferrule of column seal.  Securely tighten the column nut or 

replace the ferrule. 
b If the SS adapter is installed, adapter is loose or metal seal is worn out.  

Securely tighten the adapter or replace the seal. (refer to SS-1010E operation 
Manual 3-2) 

c The worn out septum.  (Replace the septum) 
d Gas leakage at the connection of absorption trap in split vent gas line (if 

installed).  (Securely tighten the nut and replace the seals if needed) 
e Gas leakage at the septum may occur when cooled down the injection port 

and/or interface (PY) temperature. 

WARNING  
Wear safety glasses to protect your eyes while performing the trouble 
shooting. Use care in handling the interface needle to prevent puncture 
wounds.  
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3. Install the pyrolyzer onto the GC injection port. Then make sure that the column 
head pressure reaches to the set pressure value. Use a liquid sampler for the 
trouble shooting. 

If the column head pressure does not reach to the set pressure value, perform the gas 
leakage check by following the procedure described below. 

①  Plug the carrier gas inlet tube to the GC injection port with a supplied cap. (refer 
to CHAPTER 3 in this manual). 

②  Before installing pyrolyzer on to the GC injection port, connect carrier gas tube 
to pyrolyzer. While flowing gas through pyrolyzer, plug the end of the interface 
needle with a septum to increase inner gas pressure. Wait 30 seconds then 
remove the septum. If you hear the sound of blowing out the gas from the 
interface needle, there’s enough gas flow to obtain column head pressure 
required. If you can not hear the sound, gas leakage may exist. (For more 
precise way to check out the gas leakage, a leak detector can be used.) 

When the following parts are losing or worn out, gas leakage often occur; 

• O-ring, for sealing upper end of the quartz pyrolysis tube (Fig. 6.1 b). 

Enough seal can be formed by finger tightening. If needed, 
replace O-ring (P/N: PY1-2012). Metal washer is also used here, 
which prevent gas leakage by twisting an O-ring. 

• Graphite vesper ferrule, sealing quartz pyrolysis tube and interface union 
(Fig. 6.1 c).  

Securely tighten the interface union with the supplied wrench 
and if needed, replace the graphite vesper ferrule (P/N: 
PY1-7911).  

• Metal ferrule of the interface needle (Fig. 6.1 c).  
Securely tighten the interface needle nut. If it does not work, 
interface needle assembly (P/N ： PY1-1174 ）  may need to 
replace.  

• Sampler or foreign objects on sampler base (Fig. 6.1 d). 
Securely tighten the sampler or wipe out foreign objects on the 
sampler base or the contact surface of the sampler by cotton 
swab dampened with methanol. If needed, replace a O-ring 
(P/N:PY1-7812). 

If nothing works, check breakage of the quartz pyrolysis tube (P/N: PY1-2018) 

CAUTION 
Excess force may result in breakage of the quartz pyrolysis 
tube. So work slowly.

CAUTION 
Because of the double-shot sampler has gas purging 
mechanism, it is possible to make a wrong judgement about 
gas leakage 
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4. If gas leakage can not be observed in step 3, check if the interface needle 
might be clogged. 

Clogged interface needle may show the following symptoms; 

• When removing sampler, column head pressure drops slowly.  

• Takes longer time to recover the column pressure when attach the sampler. 
• The screw nut of the sampler is tighter than usual and may hear the sound of 

blowing out the gas when loosen it. 

When observed the symptoms mentioned above, measure the carrier gas flow 
rate at the inlet of pyrolyzer and the out let of the interface needle. If the flow 
rate at the needle end is less than that of inlet of the furnace, interface needle 
might be clogged. 

Graphyte 
vesper ferruleQuartz 

pyrolysis tube 
 
ITF union 

Metal ferrule 
ITF needle 

Nut 

 

 

 

Fig. 6.1  Where to check gas leakage 

a. With flowing carrier 
gas, plug the hole of 
the interface needle 
with a septum. 
Doing this will 
increase pyrolyzer 
inner pressure 

ｂ. Pyrolysis tube securing nut
d. Liquid Sampler 

c. ITF union 

O-ring 

Back ferrule 

Nut 
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6. 4 TEMPERATURE CONTROLLER 

SYMPTOM CAUSE SOLUTION/CHECK POINTS 

1.1 
No power 

Check power source. 
Turn power ON. 

1.2 
RS-232C cable is not 
connected. 

Check the RS-232C cable is properly connected 
between PC and temperature controller. 1. 

Connection failed Error 
appears 

1.3 

RS-232C cable is 
connected to the 
different port.  

Check to see if the RS-232C cable is connected to 
that of assigned by the control software. Try to 
assign to another port numbers. 

2.1 
Heater concerned is set 
to OFF  

Set it ON 

2.2 
Circuit breaker (NFB on 
the back plane) activated

Press NFB button. 

If repeated tries do not work, repair at the factory is 
required. 

2. 
Heated block(s) is(are) not 
heated 

2.3 
Defective heater(s) 

Repair at the factory is required. 

3.1 
Sensor cable is not 
connected, or loose 
connection  

Check to see if the cable from pyrolyzer is 
connected to POWER SENSOR 

3. 
Temp. controller beeps 

3.2 
Defective sensor 

Repair of the furnace at the factory is required. 

4.1 
Fan blocked with foreign 
objects  

Check to see if foreign object such as gas pipe 
blocks the fan. 

4.2 
Defective fan 

Replace the fan. Consult to your local our agent 
4. 
Cooling fan is not 
spinning 

4.3 
No power for fan 

Check to see if the fan’s power cable is properly 
connected. Reconnect it securely. If this does not 
fix the problem, Consult to your local our agent. 
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SYMPTOM CAUSE SOLUTION/CHECK POINTS 

5.1 
Poor connection of 
sensor connector. 

Check to see if the sensor cable form the Pyrolyzer 
is properly 

5.2 
Error in calibration 

Perform the temperature calibration. 
5. 
Abnormal temperature 
shown 5.3 

Defective sensor circuit 
Short the concerned sensor signal input terminal by 
a short plug or other equivalent. Then look at its 
indicated temperature. If the temperature indicates 
far away from the room temperature, repair at the 
factory is required. 

6.1 
ITF TEMP too high 

Set ITF TEMP to auto mode. ITF temperature will 
be set to low automatically as the PY temp. is set 
to low. 

6. 
Bad temperature control 
at low temps (e.g. 100°C) 6.2 

No N2 (OR air) cooling gas 
pressure 

Check N2 (or air) source valve and pressure. 

(400 ~ 600kPa is recommended for the source 
pressure) 

7. 
Abnormal date and time 
display 

7.1 
Memory back-up battery 
is discharged below the 
level of keeping the data 
in the memory chip. 

Recharge the battery for at least 10 hours by 
keeping power on. Then set date and time. 

Check to see if the calibration factor is alive or not. 
If the calibration factor turned to zero input the 
calibration factor that is labeled on the bottom of 
the controller.  Or perform temperature calibration 
along with the procedure mentioned in this manual 
(CHAPTER 4). 

If the data are turned to the default value again, it 
is necessary to replace the battery.  Consult to 
your local our agent. 

8. 
When starts the temp 
program, GC 
status-monitoring step is 
skipped. 

8.1 
Remote signal cable is 
not connected to the 
temperature controller. 

Connect the remote signal cable. 
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CHAPTER 7  BASIC PERFORMANCE TESTS 
 
In a GC pyrolysis system the path from the pyrolyzer to the detector via the separation column is 
very important, and the pyrolyzer, interface, GC injection port, separation column, and detector 
each plays an important role. Therefore, the performance of the system as a whole is checked 
according to the instructions described below. When in operation, if problems are experienced, 
using UA-5 column (30m, 0.25mm id., 0.25µm, 5%phenylsilicon), the basic performance of the 
system can be rechecked and the problems can be identified in a shortest possible time. 
 

7.1 TESTING BASIC PERFORMANCE AS SINGLE-SHOT PYROLYZER 

7.1.1 Testing GC Performance (with pyrolyzer disconnected) 
 
Following the instruction of the GC manual install the supplied UA-5 column into GC. Inject 1µl of 
Test mixture sample into GC using a normal GC micro syringe. Fig. 7.1 shows an example of 
chromatogram. 

 

 

Analytical Conditions 
 
Column: UA-5 (5% phenylsilicon, 30m,  
         0.25mm id. 0.25µm) 
Carrier gas flow: 1.5ml/min (constant flow) 
Carrier gas total flow: 70ml/min 
Carrier gas velocity: 20 ~ 30cm/sec 
Split ratio: 1/50 ~ 1/100 
Column temperature: 70ºC~ 10ºC/min ~ 200ºC (1min)
Injection port temperature: 320ºC 
Interface temperature: 320ºC 
Inlet pressure: 140kPa 
Sample: Test mixture, 200ppm each,  
         hexane solution, 1µl 
Detector: FID 350ºC 

Fig. 7.1  GC System Performance Test

1

2
3

4

5

6 7 

8 

9 

1. undecane 
2. 4-chlorophenol 
3. 1-decylamine 
4. tridecane 
5. methylcaprate 
6. tetradecane 
7. acenaphthylene 
8. 1-dodecanol 
9. pentadecane 
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7.1.2 Testing Inertness of Flow Path and Resolution with Pyrolyzer Connected 
  (Equivalent to Data 1 in Inspection Report) 
 
Attach the pyrolyzer onto GC (see Chapter 3 for instruction). Then install the liquid sampler onto 
the pyrolyzer, and inject 1µl of the sample (Test Mix-1) used in 7.1.1. Except for the solvent peak 
which is a little broader, all the other peaks should be the same as in Fig. 7.1. 
 
If peak tailings are observed for polar compounds (especially peak No. 2, 3, and 8), pyrolysis tube 
or interface needle may be contaminated, and need to be cleaned or replaced with new one. 
Refer to CHAPTER 5 for cleaning procedure. 
 

7.1.3 Testing Basic Performance with Pyrolyzer Connected 
       (Reproducibly of pyrograms) 
 
This is the final performance test under the conditions of pyrolysis. There are two methods 
available: 1) Using standard sample that is used for checking columns; 2) Using a polymer. 
 
1) Using standard sample that is used for checking columns 
 
Test the performance according to the instruction described in 7.1.2. 
 
2) Using polystyrene for system checking (Equivalent to Data 2 in Inspection Report) 
 
The basic performance of pyrolyzer can be tested by a pyrogram of polystyrene (Fig. 7.2). 
Pyrolyzates from this polymer includes monomer, dimer, and trimer, and the ratio of these has 
been reported to be ca. 100/8/13 at pyrolysis temperature of 550ºC. Frontier Laboratories 
guarantees that using FID as the detector, the relative area of the trimer vs. monomer be 14 ± 
1.5%, and its fluctuation be within 2% (Eco-cup SF 50 µl). 

Temperature Setting for Pyrolyzer and GC
 
Pyrolysis furnace temperature: 550ºC 
Interface temperature: 320ºC 
Column temperature: 70ºC~20ºC/min ~ 320ºC (1min)
Other settings are the same as in 7.1.1 

Fig. 7.2 Pyrogram of Polystyrene 
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7.2  EXAMPLES OF EVOLVED GAS ANALYSIS AND DOUBLE-SHOT TECHNIQUE 
 

By continuously heating up a sample, following volatile components contained in the sample, 
evolved gases are generated from a polymer material as result of degradation of the polymer. 
The thermal properties of a sample can be determined by monitoring the evolved gases directly 
by a detector (FID or MS). From the evolved gas curve obtained, thermal desorption temperature 
for a volatile component as well as pyrolysis temperature of the polymer can be obtained. 

Supplied polystyrene solution for double-shot is used as a sample for the test. This sample 
solution is composed of polystyrene (6µg/µl) in dichloromethane and ca. 5％ (wt/wt against 
polystyrene) each of methylpalmitate and methylstearate. Described below is an analysis 
example with FID detector used as a detector. Based on the results obtained here, thermal 
desorption and pyrolysis temperatures are determined for the double-shot technique. 

7.2.1 Evolved Gas Analysis Tests (See Fig.7.4.1, Operating Procedure P.4-13, 4-14) 

STEP1 Attaching EGA tube (0.15mm id, 2.5m, UADTM-2.5N) for evolved gas analysis 
In place of separation column, install supplied EGA tube for evolved gas analysis into 
GC. 

STEP2 Setting up pyrolyzer and GC (see Fig.7.4.2)  
1) Set ITF TEMP to AUTO mode and set the temperature to 320 for the upper limit column 
2) Select EGA TEMP PRG and enter pyrolysis furnace temperature program described in 
    Fig. 7.4.2. 

STEP3 Loading sample 
1) Take 5µl of sample in Disposable Eco-cup SF and allow the sample to dry. 
2) Attach a double-shot stick (Eco-stick DF) to the cup and set it to the sampler as shown 

in Fig. 7.3A. With the upper slider pulled up (Fig. 7.3B) place the sampler onto the 
pyrolyzer.  Then open the purge knob, wait 3 minutes, and then close it. 

STEP4 When temperatures are stable, start the EGA temperature program 

When READY FOR INJECTION is displayed,  push down the sampler to load the 
sample into the pyrolysis furnace (Fig. 7.3C).  Then start EGA temperature program. 

 

A) Attach sample cup B) Pull up sampler slider and put it 
on pyrolyzer. 

C) Press sampler down to load the 
sample cup into pyrolysis furnace 

Fig. 7.3  Sample Loading Procedure in Double-shot Technique 
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The result should look like Fig. 7.4.2 From this evolved gas curve the following can be drawn. 
 

1) Volatile components are observed from 50ºC to 200ºC. 
2) Pyrolysis of polymer starts around 380ºC and ends around 500ºC 

 

 
Here, volatile components are observed from 50ºC ~ 200ºC in thermal desorption technique, 
hence, preferred pyrolysis temperature for the polymer should be 550ºC. (Our experiences show 
that the pyrolysis temperature that give the best reproducibility is the temperature that completes 
pyrolysis plus 50ºC.) 

Fig. 7.4.2  Evolved Gas Curve 

Temperature settings of pyrolyzer and GC 

Pyrolysis furnace temperature: 50ºC~20ºC/min ~ 600ºC 
Interface temperature: 320ºC (AUTO) 
Injection temperature: 320ºC 
Column temperature: 300ºC 
Detector temperature: 360ºC (FID) 
He: 50kPa, Flow rate: 70ml/min 
Split ratio: ca. 1/30 
ITF tube: 0.15mm id, 2.5m 

50 600(ºC) 200 300 400 500 

Fig. 7.4.1 Evolved Gas Analysis Construction 

 
EGA CAPILLARY TUBE 
（P/N: UADTM-2.5N） 

DETECTORS 
DOUBLE SHOT PYROLYZER 

SELECTIVE SAMPLER 

GC OVEN：300℃ 
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7.2.2 Analysis with Double-Shot Technique 
 

From the EGA curve shown in Fig. 7.4.2, the parameters for thermal desorption and free-fall 
flush pyrolysis are obtained. The results are shown in Fig. 7.5 A-1 and A-2. 
 
Fig. 7.5B shows the result obtained by single-shot technique using the same sample. (It is 
apparent this pyrogram contains both A-1 and A-2.) 

 

 

0 15
(min)

A-1) Thermal Desorption Analysis 
Thermal desorption temperature: 
  100ºC ~ 30ºCmin ~ 200ºC (3min) 
ITF temperature: 320ºC 
Injection temperature: 320ºC 
Column temperature: 70ºC ~ 20ºC/min ~ 320ºC(1min) 
Detector temperature: 350ºC 
Sample: 5µm of polystyrene solution for double-shot analysis
He: 122kPa, Split ratio: 1/50 

Fig. 7.5  Comparison of Double-shot and Single-shot Analyses 

B) Analysis with Single-shot Technique
Pyrolysis furnace temperature: 550ºC 
The rest are the same as A -1 above. 
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A-2) Instant Pyrolysis After Thermal Desorption

Pyrolysis furnace temperature: 550ºC 
The rest are the same as A-1 above. 

A) Analysis with Double-shot Technique 



Inspection report 
5070402 

 

DOUBLE-SHOT PYROLYZER INSPECTION REPORT 
 

 Date:  

Inspected by:  Approved by:  
The results of performance inspection of the Double-Shot pyrolyzer is reported here.  
Because data were generated with a GC at Frontier Laboratories Ltd. with the pyrolyzer 
that you received, the reproducibility of chromatogram is not warranted. 
 

ANALYTICAL CONDITIONS:   

Pyrolyzer :  Double Shot Pyrolyzer  (PY-2020iD)  Serial No.:  
Integrator: : Chrom Perfect   
Column :  UA-5 (5% phenylsilicon), 30m(0.25mm id), 0.25µm 
Carrier Gas :  He (Typical pressure  FID:122kPa, MS:60kPa ),   

Column Flow: 1.5ml/min(constant flow), Total Flow: 70ml/min 
Detector :  FID 
PY-GC Interface Temp: 320ºC   Injection Temp: 320ºC    FID Temp: 350ºC 
For other conditions, see Chapter 7. TESTING BASIC PERFORMANCE of the Operation Manual. 

   
  

Deactivation Test 
GC + PY 

Pyrolysis Reproducibility 
Test 

GC + PY 

Sample Test Mix-1 
Peak areas of monomer (S) and trimer 
(SSS) of polystyrene are used. 

Inject. volume 1µl 5µl (drying required) 

Column temp. 70ºC~10ºC/min~200ºC(1 min hold) 70ºC~20ºC/min~320ºC (1 min hold) 

PY temp. 400ºC 550ºC (actual:  ºC) 

[ INPUT PY:  ºC] 

Data attached DATA 1 DATA 2 

Judging criteria and 
actual results No abnormality of peak shapes 

1. SSS/S =       % (n=3) 
    (Criterion : 14 ± 1.5 %) 
2. Reproducibility     % 

 (n=3, Eco-cup S used) 
    (Criterion : < 2%, Eco-cup SF) 

Factory Verification 

Peak shape □ Pass □ Pass 

C
ustom

er 
Verification

Inspection at 
installation 

--------------- 
--------------- 

Peak shape (n=1) 
□ Pass 

Dealer's name :                          

Installer’s name :                            Date:                   

Customer signature :                            Date:                   

 

1-8-14,Saikon,Koriyama, Fukushima, Japan, 963-8862   TEL 81-24-935-5100  FAX 81-24-935-5102 
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LIST OF REPLACEMENT PARTS FOR PY-2020iD &PY-2020iS 
 Part Name Part No. Qty. Description 

1 Sample cups and related parts  (all cups are deactivated by proprietary technology) 

# Disposable Eco-cup SF    PY1-EC50F 1bag 50 µl, stainless steel, containing 100 pcs  

# Disposable Eco-cup LF     PY1-EC80F 1bag 80 µl, stainless steel, containing 100 pcs 

 Flow Through Eco-cup SHF PY1-EC50HF  1bag 50 µl, flow through type, disposable, containing 20 pcs  

 Flow Through Eco-cup LHF PY1-EC80HF 1bag 80 µl, flow through type, disposable, containing 20 pcs  

# Eco-stick SF              PY1-ES10F 1bag 30mm, for single-shot py, contains 50 pcs. 

# Eco-stick DF                 PY1-ES20F 1bag 80mm, for double-shot py, contains 50 pcs. 

 Eco-pick-up PY1-EP50 1pcs Eco-cup retriever 

# Eco-stand PY1-EH10 1pcs Eco-cup stand (for S and L), for sampling. 

  

2 Pyrolysis furnace parts 

# Quartz pyrolysis tube PY1-2018 1pcs 6mm o.d. (4.7mm i.d.) 

 Needle guide PY1-2014 1pcs For Liquid sampler 

 Septum PY1-2025 1bag For Liquid sampler, pale yellow, contains 10pcs 

  

3 Connecting parts 

 Interface union assembly PY1-3510 1set A set of union, interface needles (2pcs), & nut 

 Interface union PY1-3511 1pcs For graphite Vespel ferrule  

 Heat-sink adapter set PY1-3570 1set screw 2ea, 1.5mm hexagonal wrench 1ea 

 Needle Nut PY1-3512 1bag Needle nut for interface needle, 3pcs 

# Needle set PY1-1174 1set deactivated tube, 3pcs 

# Graphite Vespel ferrule PY1-7911 1bag 6mm i.d., for PY1-3511, contains 5pcs (Air Leak Free) 

 Graphite ferrule PY1-7921 1bag 6mm i.d., for PY1-3511, 100% graphite, 5pcs 

 Inlet/outlet septum PY1-2028 1bag For connecting tubes, pale yellow, with hole, 10pcs 

    

4 GC related parts   

 Septum (11mm in diameter) PY1-7301 1bag For Agilent 6890 (coated releasing reagent & conditioned, 5pcs) 

 Septum  PY1-7302 1bag For Shimadzu GCs (coated releasing reagent & conditioned, 
5pcs) 

 Glass insert (with wool)  PY1-3337 1pcs For Agilent 6890, deactivated, with deactivated wool 

 Absorption trap set 5890SV PY1-2212 1set For HP5890 split vent 

 Absorption trap set 17SV PY1-2227 1set For Shimadzu GCs 

 Absorption trap tube PY1-2216 1set Trap tubes only, packed with activated charcoal, 3pcs, for 
PY1-2212  

 GC/MS connector kit  PY1-2210 1set Ultra ALLOY cap. column connection kit for sector MS 

 GC/MS adapter MS604230 1set HP5989A,HP597x (for 0.2 to 0.32mm id columns) 

 GC/MS adapter (HP5989B)  MS604240 1set HP5989B (for 0.2 to 0.32mm i.d. columns) 

 Vent-free GC/MS adaptor MS402140 1set Vent free tube 1ea, vent free, Vent free holder 1ea, Holder 
mounting bracket 1ea, Column nut 1ea, GC/MS adaptor 1set, 
1.5mm hexagonal wrench 1ea  

 EGA tube UADTM-2.5N 1pcs 0.15mm id, 2.5m, with cage, 1 pcs 

    

    

    

    

    

Appendix-1 
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Appendix-2 
 

 Part Name Part No. Qty. Description 

5 Replacement parts set  (A supply for about a year) 

 Replacement parts set (Double) PY-K202D 1 set

 Replacement parts set (Single) PY-K202S 1 set
Disposable Eco-cup SF(2), Disposable Eco-cup LF(1), 
Eco-stick SF(1,2*), Eco-stick DF(1, 0*),Eco-stand (2),Quartz 
pyrolysis tube(3),Needle set (3), graphite Vespel ferrule (1set), ( * 
for PY-K2020S) 

     

6 Ultra ALLOY Metal Capillary Column  (Available: other liquid phases, length and film thickness,  See column brochure) 

 5% diphenyl UA5-30M-0.25F 1pcs General purpose, 30m (0.25mm id) 0.25 µm film 
 (max temp.: 380℃) 

 5% diphenyl UA5-30M-0.5F 1pcs High volatiles, 30m (0.25mm id) 0.5 µm film  
(max temp.: 360℃) 

 5% diphenyl UA5-30M-0.1F 1pcs Low volatiles, 30m (0.25mm id) 0.1 µm film  
(max temp.: 380℃) 

 UA-CW  UA-CW-30M-0.25F 1pcs Polar pyrolyzates, 30m (0.25mm id) 0.25 µm film  
(max temp.: 260℃) 

    
7 Magic Chemisober 

 Magic Chemisorber S PY1-MC01S 1set Magic Chemisorber S, 100% dimethylpolysiloxane, 6mm, 10pcs 

 Magic Chemisorber S Kit PY1-MC01S-K 1set Magic Chemisorber S 3pcs, Eco stick DF 5pcs,  
MC holder S (Flow Through Eco-cup LHF) 5pcs 

 Magic Chemisorber L500 PY1-MC01L 1set 100% dimethy polysiloxane, 500 µm 30mm, 5pcs 

 Magic Chemisorber L500 Kit PY1-MC01L-K 1set Magic Chemisorber L500 3pcs, Eco stick DF 5pcs, MC holder L 
2pcs 

 Magic Chemisorber L100 PY1-MC02L 1set 100% dimethylpolysiloxane, 100µm,30mm, 5pcs 

 Magic Chemisorber L100 Kit PY1-MC02L-K 1set Magic Chemisorber L100 3pcs, Eco stick DF 5pcs, MC holder L 
2pcs 

 MC holder  L PY1-MCP01 1set Protective tube for Magic Chemisorber L500, 3pcs 
  

  

8 Harris Micro-Puncher 

 Harris Micro-Puncher 050 HMP-0.50D 1set 0.50mm id, 10pcs, Blue 

 Harris Micro-Puncher 075 HMP-0.75D 1set 0.75mm id, 10pcs, Green 

 Harris Micro-Puncher 125 HMP-1.25D 1set 1.25mm id, 10pcs, Red 

 Harris Micro-Puncher 200 HMP-2.00D 1set 2.00mm id, 10pcs, Black 

 Harris Cutting Mat HCM-6575 1pkg 65×75mm, 5 sheets/pkg Green  

 Harris • 01Kit HMP-01kit 1set Each 3pcs of HMP-0.50D, 0.75D, 1.25D, 2.00D 
and 2 sheets of Harris Cutting Mats 

  

9 Others 

 Polymer Prepper PY1-7510 1set Polymer Prepper with two different grades of files, for Pulverizing 
samples, 3pcs, with 1roll of cleaning tape(2m) 

 Cleaning Tape PY1-7515 1set Cleaning Tape for cleaning deposited powder sample on the files 
of Polymer Prepper for repeated use, 3rolls(2m each) 
 

<> Checked (#) items are replacement parts required in daily maintenance work. 
<> Price and specifications are subjected to change. 
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Appendix-3                           

 
SUGGESTIONS / QUESTIONS FORM 

 
Thank you for purchasing our Double-Shot Pyrolyzer.  Frontier Laboratories Ltd. will 
continue to strive in improving our products by listening to our valued customers.  We 
would appreciate your suggestions in areas of product improvements. Our services, and 
analytical techniques.  To express our appreciation, we will present you a small gift to 
those who make a contribution.  Please use this form or any other form you would like 
to submit your suggestions. 
 

SUGGESTIONS / QUESTIONS 

Product name :  Date : 
 

 

Your name : 
 

Phone : FAX： 

Company or affiliation :  Department : 
 

 

Address : 
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